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User Documentation for Activity Catalog Tool (A.C.T.) v2.01_

A.C.T. is a tool for recording and analyzing sequences of activity over time. It was designed as an aid

for professionals who are interested in observing and understanding human behavior in field settings, or

for the study of video or audio recordings of the same. Specifically, the program is aimed at two

primary areas of interest: human-machine interactions and interactions between humans. The program

provides a means by which an observer can record an observed sequence of events, logging such

parameters as frequency and duration of particular events. The program goes further by providing the

user with a quantified description of the observed sequence through application of a basic set of
statistical routines. Finally, the program enables merging and appending of several files and more

extensive analysis of the resultant data.

In order to best explain the utility and potential of A.C.T., we have programmed a demonstration file
which is included on the A.C.T. disk. This file, along with the following set of instructions and

procedures, will serve as your introduction to A.C.T. We encourage you to open the demonstration file
CDEMO.A.C.T."), and follow the step-by-step tutorial provided below.

About A.C.T.

• The version of A.C.T you have received (v2.0£) is the first public release of the software. While

much effort has been spent eliminating any bugs, we acknowledge that, as with any new software, we

can not guarantee bug-free operation. Accordingly, keep in mind that we depend on you for feedback

concerning any problems with, or questions about, this software. For updates, questions, and to report

bugs, please contact Leon Segal or Anthony Andre, NASA ARC, MS 262-3, Moffett Field, CA 94035.

You may also reach us via E-mail: ieons@eos.arc.nasa.gov OR andre@eos.arc.nasa.gov

When writing articles or reports in which A.C.T. is used or mentioned, please cite:

Segal, L.D. and Andre, A.D. (1993). Activity Catalog Tool (A.C.T.) v2.0 User Manual.
NASA Contractor Report CR-177634. Moffett Field, CA: NASA Ames Research Center.

• We would appreciate receiving a copy or citation of any articles or reports in which A.C.T. is
referenced.

A.C.T. Program Requirements
• Mac II class (68020) or higher

• System 7.0 or higher (if you want _ost-processing "drag-and-drop" capability)

• Working copy of Microsoft@ Word _ or any text processor for viewing data files
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DEMO.A.C.T.

Since A.C.T. is designed to be used as a tool during field observations and video analysis, we

have picked a particular scenario - the office - to serve as the example for the illustration of
the program's functions. For the purpose of this demonstration, imagine that we were

interested in recording and analyzing the activities of a person in their office: we may be

interested in designing a new layout for the office, or providing office personnel with a new

type of information technology. We have selected eight categories of behavior which most

interest us: the person's physical position (standing or sitting), seven tasks in which they may

engage (writing, typing, reading paper documents, reading the computer screen, searching

through files or talking on the phone), and one event which may be important to note - a visitor
entering the office.

The following description of our operation of A.C.T. assumes that we are sitting in an office, or

watching a closed-circuit TV or pre-recorded video of the same, observing an individual

interact with the physical environment which comprises that office.

Running DEMO.A.C.T.

Important note for Powerbook users: Your Powerbook has several settings which help it

conserve power; these same settings will cause the graphics used in A.C.T. to look as if the clock

is not running smoothly. Note that this effect is visual only, and does not, in fact, effect the

program's clock in any way. For the sake of viewing a smooth visual interface, however, you

may want to follow these steps:
1. From the Apple menu, select: Control Panels

2. From the Control Panels menu, select: PowerBook

3. Hold down the option key and click on the "Options..." button in the Battery
Conservation box

4. a. Select: "Don't sleep when plugged in" (if you intend to use external power)

b. Select: "Don't allow cycling"

c. Select: "Standard speed"

To start the demo program (DEMO.A.C.T.)

• Double click on the "DEMO.A.C.T." file icon: this opens our previously-defined office

configuration.

• Press OK or hit the return key to pass the title screen

Enter "demo" for the data file and select Save or hit the return key: you have now named
the file in which the next session's data will be collected.

Note: You do not have to enter a file name to go to the next screen (by selecting the Cancel
button), but you will not be able to start running the session until a data file is named.

• You are now looking at A.C.T.'s data-collection interface:
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I Data File: demo IConliguration: DEMO.A.C.T.

@ll o-oo-oo.ooll@..........................nl

[read. screen I _hone ]

<stand > <sit > <write > <type > <read.p > <read.s > <search ><phone > <vislto >

A . S P F G J K h

Fre que ncg :
Tot el Time :

Notice that the keyboard-like interface is configured for those behaviors and events on which

the demonstration study focuses. Each one of the nine activities (measurements, or

observational categories) described above is assigned to one of the nine keys on the display. On

the screen, each key is attached to a label which describes the particular activity (measure) to

which the key is mapped.

The Statistics Box appears in the bottom part of the configuration screen, displaying nine

columns (corresponding to the nine configuration keys), providing the two fundamental counts of

Frequency and Total Time for each.

You are now ready to start the observation session.
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Start:
[spacebar]

Tostarttheobservationsession:Pressthespacebarorusethe cursor to select the

'"Start" button. Th(? clock _ar_ running and all glata-_ollection key_ are

activated. While the clock runs, every key press will be entered as a separate
line in the data file.

Key functions:

Different keys

may serve
different goals.

Serial keys:

These keys
record events
and behaviors

that are

mutually
exclusive.

Collecting data: Let's assume that the observed person is sitting at their desk

when the session begins. Press the '"S"key -- which is labeled "sit" N and notice

the feedback: a click sounds with the key press; a black tab appears on the key

and will remain there as long as it is selected; information in the statistics box at

the bottom of the screen indicates that the "sitting" button has been pressed once,

as well as continuously updating the length of time that button has been selected.

Notice that since the keys are configured to resemble the nine keys in the "home"

position on a keyboard, the interface is designed to afford "blind" dedication of

your fingers to the keys, thus allowing you to enter data without looking at the

keyboard.

In this demonstration, the "S" key was configured to measure both frequency and

duration of sitting. Depending on the research questions and scenario, keys are

configured to perform particular functions. Different key_ may _erve different

gg.g_ as you will see in the following section.

Now the observed person stands up. Press the "A," or "stand," button. Notice that

along with the click sound, the black tab on the key, and the information in the

statistics table, one more thing has occurred: the "sit" (S) key has been switched

off. From a theoretical point of view, this is obvious -- the observed person

cannot be seated and standing at the same time.

In the A.C.T. language, the two keys of "sit" and "stand" are considered serial

keys. Serial keys are used to catalog behaviors and events that are mutually

exclusive -- only one can occur at any _ven time. As you will see later, any

combination of keys N from two to nine keys -- can be configured as serial. There

can be more than one grouping of serial keys as well. For example, in this office

configuration, you will notice that the read.paper (G) and read.screen (J) keys are

also configured as serial.

Imagine the person standing and sitting several times and record those activities

by alternating between the A and S keys. Notice the changes in frequency and

time measurements displayed in the statistics box at the bottom of the screen.
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Parallelkeys:
These keys
record events

and behaviors

that may occur
at the same

time.

Let's assume that our subject has started talking on the phone. Press the "L" key

-- labeled "phone" -- to create a record of our observation of the person talking.

Notice that one press of the key turns it on; it will remain so until you press it

again when they have finished talking. As long as the key is "on" you will see
the black tab, as well as the incrementing of time in the corresponding cell in the

statistics box (row: Total Time On / column: J).

Now let's assume that the person starts to search through the file drawer while

still on the phone. Press the "K" key -- labeled "search.file" -- to create a record

of our observation of the person searching for a file.

Notice that pressing the K key did not affect the status of the previously-

selected "phone" (L) key. This correctly reflects the fact that one can talk on the

phone and search for a file at the same time. Accordingly, in the A.C.T.

language, the "phone" and "search.file" keys are considered parallel keys.

Parallel key_ are used to catalog behaviors and events that can take place

simultaneously.

Notice also that pressing either the "phone" or "search.file" key did not affect
the status of the previously-selected "sit" (S) key. This correctly reflects the fact

that talking on the phone and searching the file drawer did not alter the fact

that the person is still sitting. The person may talk on the phone while sitting or
while standing; they may type while reading from paper (when copying from a

book) or while viewing the computer screen. Thus, the keys that are mapped to

these activities are configured as parallel keys. As such, each can be activated

along with other parallel keys as well as other serial keys.

Any combination of keys can be configured to function as parallel keys. In fact, all

keys have the default status _)f "parallel" unless otherwise selected as serial or
event keys. Configuration of keys as parallel-, serial- or event-keys will be
discussed later in this document.

Now press the "phone" key again to record the end of the conversation. Along

with the auditory feedback you will notice the black tab disappear, as well as

the ending of accumulation of time in the "phone" cell in row "Total Time On."

Take a moment to play around with different combinations of parallel keys.
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Event keys:

These keys
record discrete

even ts.

A visitor walks in to the office. The ";" key at the extreme right of the screen is

used to record that event. Press that key; notice that this time the black tab on
the key lights up only momentarily. The ";" key -- labeled the "visitor" key in

this configuration -- has been configured as an event key. This mapping reflects

our interest in knowing how many visitors enter the office, not how long they stay.

Event keys are used to catalog the occurrence of behaviors and events at a certain

point in time: event keys record time and frequency_ of occurrence, not duration.

Thus, each press of an event key creates a time-stamped record of that event in
the data file. As is the case for the serial and parallel keys, any and all of the

keys may be configured to function as event keys, according to your own

observational requirements.

Press this key several times and note that in the statistics box only the frequency
count accumulates.

Sound:

The sound of a
key-press can
be turned off
and on.

We have pointed out that one of the sources of feedback for a key press is an

audible "click." While this may be useful for "blind" typing of inputs, it may be

too distracting in situations in where the observed subjects are able to hear the

click. To turn off the key-press sound, select Sound from the Settings menu. To turn
the sound back on, re-select Sound from the Settings menu.

Notice that the check mark disappears when Sound is turned off and reappears
when it is turned on.

Undo:
Use this

command to

erase the most

recent key-

press.
[qiZl

Suppose you accidentally hit a key or you press a key in anticipation of an event

that does not subsequently occur. Hold down the • key and press "Z" to undo the

last key-press; alternatively, you may select Undo from the Edit menu. Notice

that the black tab on the last key activated (denoted by the highlighted bar in

the statistics box) disappears, as does the data associated with that key-press in

the statistics box. The undo command is used to erase the most recent key-press.

Note: If you explicitly save data with the "Save Data" command (see Save Data

section), you cannot undo the last input performed before saving the data. Also,

you cannot undo an "undo" command.

Replace:
Use this

command to

replace one key

-press with
another.

[shift +

new key]

Suppose you observed the subject typing on the computer but accidentally pressed

the "write" (D) key instead of the "type" (F) key. Hold down the shift key and

press "F." Notice that the black tab on the "write" key disappears, while the

black tab on the "type" key lights up.

Note also that in the statistics box, the frequency and duration counts have

switched from the "D" key to the "F" key. The Replace ¢gmmand allows you to

instantly replace one key-press with another. Whatever time was accumulated

in the Total Time count of the first key (as a result of the last key-press) will be

added to the Total Time count of the second key.

ORIGINAL PAGE t$
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Pause key:

The recording

session may be
temporarily

paused, then
continued.

[delete key]

Let's pause here to review what we've done. Select the PAUSE button on the
screen (the one that looks like a stop sign) or just press the "delete" key. Pausing

A.C.T. stops the session clock and stops accumulation of _ime for all categories
that are _el_;tecl as "on" when the pause began.

The duration of the pause will be reflected in the data file in two forms: "pause

on" and "pause off" are recorded on two separate lines, each of which has the

real-time clock-stamp. Additionally, the "pause on" line displays the time on

the session-clock when pause was selected, and the "pause oft" line displays the
time the session-clock would have shown had paused not been selected, i.e.,

[time-at-pause-on] + [duration-of-pause].

Restart (Start):

[space bar]

Now select the START button or press the space bar. Note that the clock resumes

its aetivi _ty and all keys that were _elected before the pause have resumed their

accumulation of time in the statisti¢s table.

Pause the program and restart it several times. Notice that a white tab on the

delete key provides feedback of key selection, as does the very salient fact that
the clock has stopped. Also note that whichever keys (or observational

categories) were selected before the pause remain selected throughout the pause

(though they do not accumulate time) and continue being on once START has been

selected again.
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Windows

A.C.T. enables you to open three different windows during a recording session. These windows

allow you to enter text comments and to view statistics tables describing the data that has been
logged up to that point in time. We will now open and view each of the three windows.

Note: The recording session continues in the background while a window is open. Pressing any

key will close the window. If you observe a change in activity and thus have to press one of the

active keys m e.g., a key that is part of the configuration, or a function key such as the "delete"

(pause) key -- the window will close and the program will record and/or respond to whatever

key was pressed.

Statistics

window:.

Descriptive
statistics.

[qlD]

This window allows you to view several statistics that d_s_ribe the data

collected up to the point at which the window was opened. The list includes, for

each variable, the following measures: frequency, total time on, % time on,

average time on, SD time on, minimum time on, median time on, maximum time on,

and average time between on.

The statistics window may be opened through the Windows menu in the menu bar
at the top of the screen or by holding down the • key and pressing "D." Once the

window is open, pressing any key will close the window.

Remember that pressing a key that serves a function in the running configuration
will not only close the statistics window but will also activate that function.

Probabilities

window:

Transition

probabilities.
[VP]

To open this window, hold down the • key and press "P," or select Probabilities

from the Windows menu. The probabilities window displays a matrix 0escribing

the observed probability of transitioning from one observational category tP

another. The numbers represent the probability of a first-order transition from a

category on the left-hand column of the table to a category in the row at the top of
the table (see "From" and '_1"o"labels).

Remember that pressing a key that serves a function in the running configuration

will not only close the data window but will also activate that function.

POOR QL_,LIT¥
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Corn.merits

window:

Comments and

text entered at

any time will
be saved in the

data file.
[#T]

Let's suppose that at this point during the session an unexpected event takes
place. Perhaps the subject's computer breaks down, or they sit on their desk --

some event or behavior that is important, yet does not have a particular key

assigned to it. The Comments window allows you to record text not¢_ at any time

during the session.

Simply hold down the • key and press "I'," or select "Comments" from the

Windows menu. You may now enter up to three lines of verbal comments with

automatic word wrap. Although the clock looks stopped on the display, the

program continues to run. Your comments will be inserted into the data file, along

with one time stamp identifying the precise time at which you opened the
comments window and another time stamp identifying when you pressed the

'return" key -- or selected "Enter Comments" -- to exit the comments window.

Remember that pressing a key that serves a function in the running configuration

will not only close the data window but will also activate that function.
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Save, Reset and Quit

Now that you know the essentials of recording data and opening windows, we turn to the three

functions you need to know in order to complete the picture from the data collection perspective.

Save data:
Data is saved

in the data file
named at the

session's start.

[_s]

Reset:

Resetting the
session will

reset the clock

and all of the
accumulated

data records.

[_-delete]

Data is automatically saved upon quitting the program or when resetting the

program with a new data file name. You may also save the data file manually

during the session or at its end: Simply select Save Data from the File menu, or

hold down the _ key and press '_3."

Each time you save data while A.(_.T is running, a summ_ry of de_riptiv(_

statistics and transition probabilities will be printed in the data log section of

the data file. Note that these summaries only reflect the data accumulated at
the time data was saved, and thus will have different values than the final
summaries at the end of the data file.

Go ahead and save the data, using either the menu or the key combination. If you

save the data while in session, the program will continue running and collecting

data normally.

Hold down the t key and press "delete." You will be asked if you are sure you

want to reset the session. For now, in order to avoid resetting the program, press
"Cancel."

Selecting "Reset" will return the clock to zero as well a_ erase all data that

appears in the statistics window. If you start running the session again after
"Reset" was selected, the new data will write over the old data in the data file,
and no record will remain of the first session.

Note: As a safety feature, the program will ask you at each stage of the "Reset"

routine whether you are sure about resetting and replacing the existing data file.

You will also be prompted to name a new data file if you want to save data in the

original file.

Quit:
This command

terminates the

session, closes

the program,
and saves the

data.

[_Q]

You are now ready to quit the program and to learn about configurations and data

files. Select "Ouit" from the File menu. or hold dpwn th(_ _ key and pr_ "Q" to

terminate the session, save your data to file, and exit the program. You've most
probably noticed that the application has quit. Notice, however, that you now

have a new file called "demo" in your folder. This is the data file created by you

during this demonstration session.
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Data Files

Viewing data files: In order to view the data you have just collected using Microsoft@ Word ©

(or your default text processor), double-click the "demo" data file, or open it through the File
menu on the menu bar. You may be asked to select a converter, with the "Fext" option as the

default. Select "OK" (return).

You will now see your data file in an unformatted text layout. You may immediately start

reading the file. In order to more easily read the statistics tables at the bottom of the file,

however, you will need to select the entire file (Select All from the Edit menu, or press _-A)

and make two adjustments to the document's format: 1) Choose a non-proportional font, such as

Courier or Monaco, size 9 point; and 2) Set the left and right margins to 0.5" (using the arrows on

the ruler bar, or through Page Setup in the File menu).

IMPORTANT: Data files should be saved in the original 'Text Only" format in order to allow

for post data processing routines (see "Processing Data Files," p. 17). If you want to save the
data file as a Microsoft@ Word © (or other formatted) document, make a COpY _)f the text-only

data file befor_ doing so.

• Document Setup and Summary Information: At the top of the data file you will see a set of

instructions that will serve you as a reminder for the above formatting instructions, followed by

summary information displaying your file name, date and time of data collection, total

recording time, total pause time, and total time of recording session.

!

I ** IMPORTANT! IMPORTANT! IMPORTANT! IMPORTANT!

' TO read or print this file in MS Word:

!

' i) Select all of the text in the file

' 2) Set the font to a non-proportional font

' like Monaco or Courier, 9 pt.

' 3) Set left and right margins to 0.5 in.

' using Page Setup

1

i

I

!

i

!

!

!

!

Data File: 'demo'

Date & Time: Thursday, December 23,

Recording Time: 0:17:41.32

Paused Time: 0:01:13.08

Total Time: 0:18:54.40

1993 12:58:37 PM

• Data Log: Under this header you will find the Data Log. Here is where your time-

stamped inputs are displayed, in chronological order. Data in the log is organized in four
columns presenting, from left to right: 1. Key type and action; 2. Session time; 3. Real time; 4.

Key label and action. Actions are coded as "+" for ON and "-" for OFF.
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Here is a sample Data Log:

! V

! v

! v

#+ 0:00:00.00

S+ 0:00:24.25

A+ 0:00:32.80

S+ 0:00:44.50

A+ 0:00:45.42

S+ 0:00:49.65

L+ 0:00:54.67

K+ 0:01:00 80

K- 0:01:18 78

L- 0:01:38 02

F+ 0:01:38 77

J+ 0:01:40 07

;- 0:01:56 47

@+ 0:02:03 45

@- 0:02:16 63

! Comment becan

! This is where

@+ 0:03:02.77

@- 0:03:05.78

S- 0:03:02.78

F- 0:03:02.83

J- 0:03:02.90

#- 0:03:02.95
!

Data Log

04:10:12

04:10:36 "sit"+

04:10:45 "stand"+

04:10:56 "sit"+

04:10:57 "stand"+

04:11:02 "sit"+

04:11:07 "phone"+

04 :Ii :13 "search. file"+

04 :ii :31 "search. file"-

04 :II :50 "phone"-

04:11:51 "type"+

04:11:52 "read.screen"+

04:12:08 "visitors"-

04:12:15

04:12:28

at 0:02:53.85 and finished at

text comments are added

04:13:28

04:13:32

04:13:32 "sit"-

04:13:32 "type"-
04:13:32 "read.screen"-

04:13:32

0:03:04.36

Several symbols appear in certain rows in the first column:

#+ This is A.C.T.'s symbol for "Start Session."

#- This is A.C.T.'s symbol for "End Session."

@+ This is A.C.T.'s symbol for "Start Pause."

@- This is A.C.T.'s symbol for "End Pause."

! This precedes any entry that is not a data record, such as a text comment.

Since the Data Log is formatted to display one line per each key press, long observational

sessions may generate data files that are several pages in length. For this reason, at the end of

the Data Log you will once again see the data file summary information seen at the top of the

program.

• Configuration Setup: Under the summary information you can see the Configuration Setup.

This describes the observational category defined for each key and the particular function --

e.g., event key, serial key -- allocated to different keys. Remember, since all keys function as

parallel keys by default, the program only lists those keys which were specifically defined
otherwise.
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Configuration Setup

Configuration File: 'DEMO.A.C•T.'

Configuration uses Both hands.

A' --> "stand"

S' --> "sit"

D' --> "radio"

F' --> "type"

G' --> "read.paper"

J' --> "read.screen"

K' --> "search.file"

L' --> "phone"
• ' --> "visitors"

Serial keys = ( 'A', 'S' )

•T Serial keys = ( 'G', 'J' )

! Event keys = ( ';' )

V

V

• Statistics Summary: Below the Configuration Setup, you will see statistic tables describing

your total set of data. These tables are identical to the tables you saw earlier when you opened

the "Data" and "Probabilities" windows•

The first table describes, for each variable, the following measures: frequency, total time on, %

time on, average time on, SD time on, minimum time on, median time on, maximum time on, and

average time between on.

The second table is a transition matrix listing the probability of first order transitions from one

observational category to the other; enter the appropriate row and go across to the appropriate

column to find the probability of transitioning "From" one behavior or event 'To" another.

• Text Comments: At the bottom of the data file, you will see a summary of all text comments

entered during the session. These are redundant with the comments listed individually in the

Data Log and are grouped together for your convenience.

IMPORTANT: Data files should be saved in the original 'Text Only" format in order to allow

for post data processing routines (see "Processing Data Files," p. 17). If you want to save the
data file as a Microsoft@ Word © (or other formatted) document, make a copy of the text-only

data file before doing so.
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Customizing Your Own Configuration

A.C.T. was designed to allow for easy configuration of its interface, including labeling of keys,
definition of key types (parallel, serial or event), and preferred mode of key layout (left

handed, right handed, or both hands). By default, if you open A.C.T. by double-clicking on the

A.C.T. icon, the keys are arranged for input with both hands, all key labels map to the key's
letter, and all keys are in the parallel mode.

Open A.C.T. by double-clicking on the A.C.T. program icon. Enter any name you choose for the
data file (Note: Do not use demo.1, demo.2, or demo.3 -- these will be used later in the

tutorial). You are now looking at the default configuration. The following instructions will

take you through the different options that are available for customizing the configuration to

your own needs.

Key layout:

The layout o/

displayed keys

can be changed

to allow typing
with both or

either hands.

Before you start labeling individual keys, you need to decide on the general

layout of the on-screen keys. Would you like to type your inputs with both

hands? Will you need to take notes with one hand while entering data with the

other? Are you left handed or right handed? A.C.T. was designed to allow you to

customize the key layout to your needs.

As you can see, the default layout is for entering data with both hands. You may

change the layout of the keys by selecting 'Type with Left Hand" or 'Type with

Right Hand" from the Settings menu, or by pressing _-L or _-R to select a left- or

right-handed layout, respectively. Selecting (_-B) will return the layout to the
both-hands setting.

Select different layouts to familiarize yourself with this capability. Leave the

configuration in whichever layout you prefer.

Note: The keyboard layout can only be changed before data collection has
started.

Map keys
mode:

In this mode,

you define key

function and
label, and
customize the

clock.

[_M]

To enter the mapping mode, you may either select "Map Keys" from the Settings

menu, or hold down the t key and press "M." As you will see, the Start, Pause

and Reset keys have been disabled, indicating that you can not run a data

collection session in this mode. Note that the clock window has changed its

shading: this informs you that the clock settings may also be changed.

In all. three things may be modified in the Map K_y_ mode:

• Key labels

• Key functions

• Clock settings
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Key labels:

Key labels may
be changed to

reflect

different
categories of
observation.

There are two ways to input label names:

Press the tab key. Notice that the label for the "A" key has been highlighted.

You may now write text into this label. When you've finished entering your label

name, pressing tab again will highlight the next label (letter "S"); pressing enter
will remove the cursor from the "A" label window. Repeated presses of the tab

key will move the highlight through all label boxes. When the last (right-

most) label is highlighted, a press of tab will highlight the first (left-most)

label again. Pressing Shift-Tab will highlight the previous label.

Place the cursor on the label box for "A" and double-click: the box is highlighted.

You may now write text into this label. When you've finished entering your label
name, move over to the next label (letter "S") and double-click to highlight it.

You may now write text into this label. This same procedure can be used to label

all the keys.

Key functions:

Keys can be

defined as

parallel,
serial, or event

keys.

By default, all keys are defined as parallel keys.
To define serial keys:

Using the cursor and holding the shift key down for multiple selections, select

those keys which you want to group as serial, i.e., mutually exclusive keys. You

may also hold the cursor key down and drag the mouse to select multiple keys, as

you would to select multiple objects/text in other Apple Macintosh applications.

When all related keys have been selected, open the Settings menu and select
"Define Serial Controls" or hold down the • key and press "G. "When you collect

data using this configuration, this group of keys will act serially.

Note: You may define more than one group of serial keys. Once you have defined

one group, simply click the cursor on another set of keys you wish to define as
serial.

To define event keys:

Using the cursor, select the key(s) to be event keys. From the Settings menu, chose
"Define Event Controls" or hold down the _ key and press "H. " When you collect

data using this configuration, these keys will act as event keys.

"Undefine" key
functions:

To return serial or

event keys to

parallel function,

select Undefine

Controls from the

Settings menu.
[_Ul

When modifying an existing configuration or to correct a mistake while creating a

configuration, you can Undefine individual and groups of keys that were

previously defined as serial or event keys according to the following instructions.

Make sure you are in the "map keys" mode by either selecting "map keys" from

the Settings menu or by holding down the • key and pressing "M."

Using the cursor, select the key or group of keys to be undefined. Note that for

serial key groups, selecting any one of the keys will highlight all the keys

associated with that grouping.

Either select "undefine controls" from the Settings menu or hold down the

key and press "U."
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Setting the clock:
The session clock

may be preset to

match any other
clock.

Sometimes you may want to synchronize the session clock with a particular clock,

such as a time stamp on a video tape. Changing the clock setting from the default

setting of 0:00:00.00 is done by individually changing each one of the segments
(hours, minutes, seconds, or one-hundredths of seconds).
To reset the session clock:

Place the cursor on the particular segment you wish to change

(hour/minute/second/100th). Double-click to highlight the segment and enter
the desired setting.

Note: For obvious reasons, you may not enter numbers higher than 24 in the hour

segment, numbers higher than 60 in the minute and second segments, and numbers

higher than 100 in the 100ths segment.

Saving the new

configuration:
Anytime you exit the "Map Keys" mode after changing or creating new labels or

key functions, A.C.T. will prompt you to save the new configuration. We
recommend that you always take this opportunity to name and save your

configuration by selecting "yes" when prompted.

open 
pre-defined

configurations:

Three ways to start A.C.T.:

1. Click on program icon, then select "Open Configuration" from the File menu.
2. Click on configuration icon.

3. Drag and drop configuration icon into program icon.
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Processing Data Files

A.C.T. allows you to manipulate the date three additional ways, two of which allow you to combine

separate files into a larger file (append and merge) and one which provides you with added statistical

analyses (concurrency analysis).

Appending or merging data files allows you to do two things:
• You may take multiple files and append them sequentially into one long file; A.C.T. will

subsequently provide you with the statistical analysis of the resultant file.

• You may have two or more observers collecting data simultaneously, each using his or her

own computer and focusing on different activities -- in effect, each operating a different subset

of keys from the same configuration. Their data files may be merged to create one

comprehensive file that includes all observations. The same can be done when transcribing a

video recording, where one performs multiple passes over the same segment, each time creating
a data file that describes different activities, in effect, using a different subset of keys from the

same configuration.

Concurrency analysis allows you to :
• Examine the concurrence of different combinations of activities and events from a single file,

or from an appended or merged file.

To Perform Data File Post-Processing:

To perform any one of the post-processing data file manipulations, you must follow the next

steps:
1. Select those files that you would like to process.

2. Select the configuration that was used to create those files.

3. Drag and drop the selected files and the configuration together on to the A.C.T. program
icon.

We have provided you with three data files -- demo.l, demo.2, and demo.3 -- with which you
can learn about A.C.T.'s data-file processing functions. All these files were previously created

using the DEMO.A.C.T. configuration. Select the three data files and the configuration file,

then drag and drop them onto the A.C.T. program icon.

IMPORTANT: Data files should be saved in the "Text Only" format in order to allow for post

data processing routines (see "Processing Data Files," p. 17). If you want to save the data file
as a Microsoft@ Word © (or other formatted) document, make a copy of the text-only data file

before doing so.

At this point, the A.C.T. Data File Post-Processing window will open.
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A.C.T. Data File Post-Processing

{_ Merge Files

0 Append Files

Arrange the order of the files by dragging them into position.

File Names: Start Time End Time Session Time

demo. 1 0:00:00 0:00:02 0:00:02

demo. 2 0:00:00 0:00:02 0:00:02

demo. 3 0:00:00 0:00:03 0:00:03

(Save As... 1 (Customize Concurrence... 1 I CANCEL 1

Appending
files:

This process

allows you to

create one long
file from
several shorter

files that were
recorded in a

sequence.

Select the Append Files button in the top left-hand corner of the window.

Note: The two fields that open in the right hand corner when you select Append

Files are currently not functional. Subsequent versions of A.C.T. will allow you to
use these buttons for greater control of data file processing.

When you append files, you are creating a chain of files which are connected

"head to toe." A.C.T. allows you to select the particular order in which you want
to append the files.

Notice that all the files you had chosen to manipulate appear in the A.C.T. Data

File Post-Processing window. The order in which they first appear is determined

by Session Time (from shortest to longest file). The files will be appended in the

order in which they appear, with the top file first and the bottom file last.

To change the order in which the files appear in the window:

"Drag and drop" the line of text corresponding to each file to the desired location

in the sequence.
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Merging files:

This process
allows you to

create one file

from two or

more files that
were recorded

at the same

time.

Select the Merge Files button in the top left-hand comer of the window.

When merging files, A.C.T. consults the session clock to produce a file that
combines all the activities and events according to the time at which they were

recorded. For example, if one file has event A at 00:01 and event B at 00:08, and
the other file has event C at 00:05, the merged file will have event A at 00:01,

event C at 00:05, and event B at 00:08.

IMPORTANT:

• You can only merge files that were recorded using the same configuration.

• You can only merge files in which different keys from the same configuration

were pressed, i.e., the same key (activity) cannot appear in more than one file.

• You can not merge files which "split" groups of serial keys. That is, members of

serial key groups can only be activated within the same file.

Conctttrency

analysis:

This procedure

produces two
new data tables

which present
statistics

regarding the

occurrence of

combinations of
activities.

One of the analysis tools that A.C.T. provides you with allows you to look at the
concurrence of different activities and events. You might want to know: How

often did the person talk on the phone while standing? How much time did the

person write while sitting?

A.C.T. will print out all single activities and all possible combinations of two or
more activities that were recorded concurrently in the session. (Notice that the

"null" set of "no activity" is included in this listing.) Simply select a single file

and its configuration and "drop" them into the program icon. When the A.C.T.

Data File Post-Processing window opens, just click OK.

These data are presented following the statistical summaries described above

(DATA FILES) in the form of two tables.

Description of

concurrency tables:

!All single and concurrent activities, sorted by total duration

!(Listed single keys and combinations ONLY)

This table lists all recorded activities, including single activities, mutually

exclusive combinations of keys, and the "null set." For example, the row that

describes the concurrency of activities X and Y includes only those times when X

and Y alone were activated; if activity Z came on while X and Y were on, the

data is included in another row, namely, in the X and Y and Z row. The list is

ordered by total duration, from longest to shortest.

[All concurrent activities, sorted by total duration

!(Listed key combinations, REGARDLESS of other concurrent activities)

This table lists all possible combinations of 2 or more recorded activities. For

example, the row that describes the concurrency of activities X and Y includes all
times that X and Y were on at the same time, regardless of what other keys were

activated at that same time. The list is ordered by total duration, from longest to

shortest.
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Customizing

concumency
analysis:

You can define

particular
activities that

interest you and

create your own

concurrency
tables.

Remember that since all possible combinations of activities are presented in both

default tables described above, the particular combinations which interest you

will be included in this table. However, customizing the concurrency analysis

will produce two tables which present only those combinations that interest you,

thus freeing you from the need to search through what may be very long " !All
single and concurrent..." and "!All concurrent activities..." tables.

To perform this customized concurrency analysis, you need to select the Customize

Concurrence button in the A.C.T. Data File Post-Processing window. A new

window will open: "A.C.T. Concurrent Activity Selection"

A.C.T. Concurrent Activity Selection

Select the concurrent activities for each

Activity:

(A) - "stand"

(S) - "sit"

(D) - "write"

(F) - "type"

(G) - "read.paper"

(J) - "read.screen"

(K) - "search.file"

(L) - "phone"

(;) - "visitors"

group:

#I #2 #3 #4 #5 #6 #7 #8

D D D D D D D D
FI FI FI I-I l-! I-I I-I [-]
O O O O O D D Ci

D D D D D D D D
FI I-I D I-I ID Ci I-I ID
D D D D D D D D
D D ID D D D D D
D D D D D D D ID

E] FI F1 D F! I-I I-I D

ICflNCEL'_

You may select up to 8 customized combinations of activities. Combinations of activities are

described in columns. You define the specific combination(s) by selecting the desired

combination of boxes which correspond to the list of activities on the left hand side. Once you

have defined one or more combinations, click OK. Click OK again in the A.C.T. Data File
Post-Processing window. In addition to all data tables (see DATA FILES section above), and in

addition to the two concurrency tables described earlier in this section, the Concurrent

Activity Table section of the data file will have two new tables:

"!All single and concurrent activities, selected by user

!(Listed single keys and combinations ONLY) "

This table presents only those unique activities, and/or combinations of activities, which you

had selected in the customization of concurrency analysis.

" !All concurrent activities, selected

!(Listed key combinations, REGARDLESS of other concurrent activities) "

This table presents all the possible combinations of those activities which you had selected in

the customization of concurrency analysis.
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Summary

We have put much thought and time into making A.C.T. intuitive to operate. While we hope
that the above instructions provide concise answers to questions you have, we believe that most

questions can be answered simply by playing with the program. We encourage you to explore
A.C.T.'s functions and capabilities in your daily surroundings: study your partner's activities as

he/she cooks in the kitchen, try to find patterns in dialogs you hear on TV shows, or analyze

the strategies employed by your favorite sports team. Remember that observational data
collection depends primarily on the observer; A.C.T. is merely a tool, the utility of which will

be defined by your choice of context and manner of application.

As these lines are written, we are aware of constraints and limitations inherent in our design.

We intend to further refine this program and to add functions and capabilities that it does not

currently provide. To this end, we depend on your feedback and inputs. Please send your
comments to the address provided on the cover page, and keep in touch to receive our program

updates.

We truly hope you enjoy A.C.T., and that in the course of its use, you find it a versatile and

productive tool.
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Key Commands

F_ceon

Comments

Key command

liT

Create Data File liN

Define Event Controls li H

Define Serial Controls liG

Map Keys liM

Open Configuration liO

Pause delete

Probabilities liP

Quit liQ

Replace

Reset

Save Data

shift-lnew key]

li-delete

liS

Description

The Comments window allows you to record text notes

at any time during the session.

New data files can be created with this command.

Event keys are used to catalog the occurrence of

behaviors and events at a certain point in time; event

keys record time and frequency of occurrence, not
duration.

Serial keys are used to catalog behaviors and events
that are mutually exclusive -- only one can occur at

any given time.

In this mode, you define the function of each key

and give each key a label.

Use this command to open previously-defined

configurations.

Pausing A.C.T. stops the session clock and stops
accumulation of time for all categories that are

selected as "on" when the pause began.

Note: Pause can also be performed via a button on the

display

The Probabilities window displays a matrix

describing the probability of transitioning from one

observational category to another.

This command terminates the session, closes the

program and saves the data.

The Replace command allows one to instantly replace
one key press with another.

Resetting the session will reset the clock and all
accumulated data records.

Note: Reset can also be performed via a button on the

display

Data is saved in the data file named at the start

of the session.
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F_ction

Start (restart)

Statistics dD

Type with Both Hands d B

Type with Left Hand dL

Type with Right Hand dR

Undefine Controls d U

Undo dZ

Hitting the space bar will (re)start your data
collection session.

Note: Start can also be performed via a button on the

display.

The Statistics window allows you to view several
statistics that describe the data collected up to the

point at which the window was opened.

Selecting this option will configure the A.C.T.

interface to two-hand typing.

Selecting this option will configure the A.C.T.
interface for one-hand typing using the left hand.

Selecting this option will configure the A.C.T.
interface for one-hand typing using the right hand.

Use this command to undefine previously-defined

event and serial keys.

The undo command is used to erase the most recent

key press.
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